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Setting up Procedures for Processing JACoW Style Papers

These instructions assume that Acrobat 7 is and PitStop have been installed.

Job Options for Distiller
When you start distiller make sure that the correct Job Options file is selected (JACoW-09):

Job Options are stored in

C:\Documents and Settings\ All Users\ Documents\ Adobe PDF\ Settings in Windows XP and
C:\Users\Public\Public Documents\Adobe PDF\Settings in Vista,

but you can import them again if they are corrupted.

From the editor instructions page click on the Distiller JobOptions link and download the file
to your machine.

Start Distiller and click on Settings and select ‘Add Adobe PDF Settings’ and them simply
replace your joboptions file with the one which you downloaded.

B2 Acrobat Distiller
File Settings Help

Adobe PDF Settings
Default Settings: E.J,'-\.an-l}ﬁ V|
Compatibility:  Acrobat 7.0 (FDF 1.6)
A Setup for JACoW - paper size, embed all fonts, compression, Acrobat 7 compatibility.
W

Progress
Status: Ready

Pause

POF File Size Time PS5 File Size ﬂ Settings POF F
MCOYCMHO1 PDF 404 KB 0:00.02 MOYCMHODI.PS 1955KB JACoW-05 l'.:ﬁ CN
TUXF{ADZPDF 1381KB 0:00:13 TUXRADZPS 116760 KB  JACOW-DS l'._ﬁ CN
WEPECO02PDF 1020KB 0:.00.05 WEPECOD2PS 3.757KB JACoW-05 l'.:'E CN
THPEBO78PDF  1130KB 0.00.08 THPEBO7BPS 13.827KB JACoW-05 l'.:'E CN

[BETHPPIHOA FDF 435 KB 0.00:02 THPFMHO4FS S20KB JACoW-09 b= cv
% | >
T DR TG T O T T

Source: TUXRADZPS s

Degtination: C:\Corferences P AC 10%download test\TUXRADZ FDF

Adobe PDF Settings: E-\Dokumente und Einstellungen®All Users \Dolcumente'Adobe PDF\Settings
"WJACoW-09 joboptions

%[ ProductMame: Distiller %%

Page: 1]iL.%
Page: 2]
Page: 3]
Page: 4]
Page: 5]
“i[LastPage]ii

Digtill Time: 13 seconds (00:00:13)
= End of Jab "

|£

The settings should look like those on the following pages.



JACoW-09 - Adobe PDF Settings

¥ JACow-09
[C] Images
[C] Fonts
23 Color
£ Advanced
(£ Standards

[] Show &l Settings

Descn'pﬁan
Setup for JACoW - paper size, embed all fonts, compression, Acrobat 7 compatibility.

File Cptions
Compatibility: |F~c:mbat 7.0 (PDF 1.86) v|
Object Level Compression: |0f‘f L |
Auto-Rotate Pages: |0ﬁ v|
Binding: | Left v|
Resolution: ‘ﬁ{m dots perinch
%) All Pages

(") Pages From: | To: |

[] Embed thumbnails
Optimize for fast web view

Diefault Page Size
Width: |595.0 | Units: | Poirts v

Height: [791,0
% ] (] (]

JACoW-09 - Adobe PDF Settings

¥ JACow-09
[ General
[C] Fonts
23 Color
£ Advanced
(£ Standards

Color Images
Downsample: |Bicubic Downsampling to L | !3W T !DHBIS perinch
forimages above: (450 % |pixels perinch
Compression: |A|_rlomatic UPEG) V|
Image Quality: | Maximum b
Grayscale Images
Downsample: |EiCUbiC Downsampling to b4 | IE{H} c ||::ixe|s perinch
forimages above: (450 & ||::'|xe|s perinch
Compression: |.P~.|.rlomatic UPEG) V|

Image Quality: | Mapdmum b

Monochrome Images

Downsample: |Eicubic Downsampling to w | I121}I} 5 |Pi?€9|5 perinch

forimages above: |1800 |2 |piels perinch

Compression: |[I“|'I_I' Group 4 W |

Anti-glias to gray: | Off w |

[] Show &l Settings

Palicy
T e




Adobe PDF - Image Policy

Color Image Palicy
When image resolution is below: | 300 % | piels perinch

| lgnaore |

Grayscale Image Policy
When image resolution is below: | 300 % | piels perinch

| lgnaore L7 I

Maonachrome Image Policy
VWhen image resolution is below: | 1200 % | pixels perinch

| lgnore L7 I

JACoW-09 - Adobe PDF Settings

E | SC%W%I Embed all fonts
enera
[] Embed OpenType fonts
[ Images
[] Subset embedded fonts when percent of characters used is less than: I:l L
Color
Only fonts with appropriate permission bits will be embedded
£ Advanced
Standards
= When embedding fails: | WWam and continue w
Embedding
Font Source: Always Embed:
2 : T TimesMNewRomanPS-Boldita A
EHVRIDAING i Fonts D T TimesNewRomanP5-BoldM™ —
T Abertus-Bold e T TimesMNewRomanPS-talich
T Albertus-ExtraBold = | A T TimesNewRomanPSMT
T Albertus-Medium g T Trebuchet-Boldhalic -
T AbertusMedium-ttalic T TrebuchetMS
T AntiqueQlive T TrebuchetMS-Bold e
T AntiqueQlive-Bold
T AntiqueCliveCompact-Requlz N e
T AntiqueQlive-talic i il
T Anal-Black
T Aral-Blackitalic
T Anal-BolditalicMT
T Anal-BoldMT
T Anal-talicMT
T AialMT
T AralNamow bt
[[] Show Al Settings
x| (o= e

Note that all fonts have been selected from ‘Font Source and added to
‘Always Embed’



JACoW-09 - Adobe PDF Settings

& JACow-09
[Z3 General
2 Images
[C Fonts
[C3 Advanced
[Z3 Standards

[] Show &1l Settings

Adobe Color Settings
Settings File: | MNone V|

Color Management Policies

Leave Color Unchanged hd |

Document Rendering Intent: | Preserve V|

Waorking Spaces
Gray:
RGE:
CMYK:

Device-Dependent Data
] Preserve under color removal and black generation

When transfer functions are found: | Preserve W

[] Preserve halftone information

savess. | | Ok | [ cancd | [ Hep

JACoW-09 - Adobe PDF Settings

¥ JACow-09
£ General
21 Images
[C Forts
23 Color
Advanced
L Standards

[] Show All Settings

Options

[] Mlow PostScript file to overide Adobe PDF settings
[] Allow PostSeript X0bjects
Convert gradients to smooth shades
[JConvert smooth lines to curves
Preserve Level 2 copypage semantics
Preserve overprint settings

Cwverprinting default is nonzero overprinting
Save Adobe PDF settings inside PDF file
Save orginal JPEG images in PDF if possible
[] 5ave Portable Job Ticket inside PDF file
[ ] Use Prologue ps and Epilogue ps
[]Create Job Defintion Format (JOF) file

Document Structuring Conventions (DSC)
[[] Process DSC comments

[ savess. | [ ok | | cCamcel | [ Hep




JACoW-09 - Adobe PDF Settings

ﬂ éﬂgw-ﬂﬂl Standards Reporting and Compliance
enera
[ Images Compliance Standard:| Be Vl
% Ec;ll'rts When not compliant:
or
(£ Advanced
=) L gither TrimBax nor ArtBox are Specifie
if Neither TrimB ArtE Specified

Leﬂ s HJghtl - | 'I.'o;::| | Bottom:

I BleedBax is Mot Speciied

Leﬂ:| Right: | | Top: | | Battom: |
Default Values i Mot Specified in the Document
Output Intert Profile Mame: L :'-.'Q:i

Output Condition Identifier: |

Cutput Condition: |

Registry Name (URL): |

Trapped:

[] Show All Settings

Save As] [ QK ] [ Cancel ] [ Help

Acrobat Distiller Preferences

Distiller Preferences

Select File > Preferences and set up as follows:

Preferences - Acrobat Distiller

Startup Alerts

QK
Motify when Watched Folders are unavailable -
Naotify when Windows TEMP folder is nearty ful
Output Options
-p
[ ] A=k for PDF file destination

Azl to replace existing PDF file
View PDF when using Distiller

Log Files
Delete Log Files for successful jobs

These preferences control the Distiller application. For Adobe PDF
0 Printer settings, rnght-click the Adobe POF prnter and choose Printing
Preferences or Document Defaults.




Acrobat Professional Setup
Most of the default settings are irrelevant — just set the following by selecting:
Edit > Preferences> General

Preferences

Categories: Miscellaneous
| 30 Lad Automatically save document changes to temporary file every 5 minutes (1-93)
Accessibility

Batch Processing (] Automatically detect URLs from text Reset All Warnings
| Catalog Open cross-document links in same window
| Color Management
| _ g Save As optimizes for Fast Web View
| Commenting
| Convert From PDF (] Emit passthrough PostScript when printing
| Convert To PDF Enable print preview

borms [] use singlekey accelerators to access tools
| Full Screen
[]Enable text selection for the Hand tool
| Identity [] Disable edit warnings
| International
L fntesnat Show documents in taskbar (tskes effect after next launch of Acrobat)
| JavaScript

Measuring Selection

Multimedia ekt Cokne: |—v|

Page Display elect Toal Optians: | Text befare images

Reading ; ’ -~ :

: 10

iEviewiri Text Selection Margin & ] pixels
| search ) ) & )
| Column Selection Margin: 20 wels
| Security 2 - B
| Speling [Juse fixed resolution for snapshots Resolution: pixels/inch
| Startup

TouchUp

Trust Manager Version Cue
| Units & Guides — []Enable Yersion Cue workgroup file management
| Updates

Web Capture N

[ OK ] l Cancel ]

Preferences

Categories: Page Display

3D v Default Page Layout: | Single Page N
Accessibility B ' '
Batch Processing [ pisplay art, trim, bleed boxes
Catalog Display large images
Color Management

[Ipisplay page to edge

Commenting
Convert From PDF [Iispiay transparency arid
Convert To PDF Use logical page numbers
EO:—IH;S [Juse CoolType {Recommended for laptop/LCD screens)

ull Screen
o] [ overprint Preview
Identity Smooth text Smooth line art Smooth images
International
Internet [Tuse greek text below pixels
JavaSaipt
Measuring
Multimedia
Page Display Resolution
Reading : : :
R (%) Use system setting Current Display: 96 Pixels/Inch
Search O - "

Custom resolution: Pixels/Inch
Security e
Spelling
Startup Maagnification
Touchlp Default Zoom: |A|.|tomaﬁc ~ |
Trust Manager
Units & Guides Max Fit Visible Zoom: | 1600% v|
Updates
Web Capture b
[ Ok ] [ Cancel




Preferences

Categories: Opening Documents
3D Maximum documents in most-recently used list: | 2 |10
Accessibility
Batch Processing Remember files in Organizer History for: | Last 14 days N |
Catalog
Color Management
Commering Reopen Documents to Last Viewed Page: | Digital Editions Only v |

Convert From PDF
Convert To PDF

[ dUse page cache > |Confirm not checked

Web Capture

Forms
o 7 :
il i [+] Allow layer state to be set by user information
General Display the Document Status dialog when these status items appear:
Identty. [l Documents with layers
International
Internet [l secured documents
JavaScript Certified documents
:Elfu”;g [ signed documents
Lltimedia
Page Display [ Documents that enable extended features in Adobe Reader
Reading Documents with object data
Revigwing [ bocuments with file attachments
Search
Security
Spelling Application Startup
Startup 3
Tatichilp [pisplay splash screen
Trust Manager D x 2 : :
Use only certified plug-ins Currently in Certified Mode:  |No
Units & Guides !
Updates

OK.

] [ Cancel

]

Preferences

Categories:

D
Accessibility
Batch Processing
Catalog
Color Management
Commenting
Convert From PDF
Convert To PDF
Forms
Full Screen
General
Identity
International
Internet
JavaScript
Measuring
Multimedia
Page Display
Reading
Reviewing
Search
Security
Spelling
Startup
TouchUp
Trust Manager
L
| Updates
| Web Capture o

1

Units

Page & Ruler Units:

Layout Grid
Width between lines:
Height between lines:
Grid offset from left edge:
Grid offset from top edge:
Subdivisions:
Grid line color:

Guides

Guide color:

|ports ]

= |as3pt
 |e80 pt
= |ss pt

* |s4pt

Bk

w W

l [ Cancel




Set up PitStop Action List

In Acrobat Professional hit CTRL-ALT-A to start the PitStop Action List interface. You can
either download the script (JACoW Media Box) from the Editor instruction pages and import

it or set it up manually:

Click ‘Plug-Ins’ in ‘Acrobat Professional’ (Acrobat 7 + PitStop 7.5 or later only)
Select ‘Enfocus PitStop Professional’
Click ‘Show Enfocus Action List Panel’
Click on ‘Action Lists’
Click ‘Manage...” Tab

Click ‘New...” button

Action List And PDF Profile Panel

=

Default Action Lists

= Local Action Lists
manual-cut

Acrobat 7 Specific

Color

Document and Pages

Forts

Images

JACoW

Import...

HEHEHBBH

Sort 3
my
Overprirt Ed?w Cahegory_.
Page Boxes and Printer Marks i '
PDF-Version-7
Penguins
Preflight - Addttional Checks

B H

Export Category...

Prepress General Import th.agory. "

Repurposing

HEEHE

Run on:

| complete document v| |_ |

[Al

Show results I~

Never v | ’

Run

General Information:

M Action List Name: |Unt'rt|ed |
Author: | |
Select all
Company: | |

Action List Description:

Change ‘Action List Name’ to ‘JACoW’
Click “+’

New Action Type for Action List: JACOW (3]
General Information: Types Actions
Change comupt fort widths A
w i I ﬁ e
Lacking Information Action List Name |JACDW | - @ (Change crop box
Author: Al Change dash pattem :
Select all = | | Change default color spaces |
Company: | | ; :a ‘ 2 ; ‘ Change document encoding
i D 2 — Change document infa
an escription: Selections Changes Checks  Informs Change fill and/or stroke
Resize MediaBox to JACoW Format Categories (Change fill type
Remove CropBox Change flatness
[ O - (Change font
Al R Eavores Change imagfa compression
= Change layering
- ey | Change line cap
= "
=1 ‘ I ‘ ‘I < Change line join
Page Text Line At Change line weight
o) —
8 BH o e
Color Image Add/Remaove Change OPlirfo
__ﬂ_l 1 ';] Change ovemprint
B 2 3 _= | Change overprint mode
Prepress Position/Size Operator  |Change page blending color space
o Change page box layout
B =] Al v} % a Change page fomat
S o K 2| H| G| o ¥
_:ﬂ u Metadata Doc General
Fiter [ A }
[Cancel ] ‘ | [ Add to Favorites }

Choose ‘Change media box’ and click Add



2 8 3

Selections Changes Checks  Informs

Action Type for Action List: JACoW

Enfocus Action List Editor; Untitled
Attrbutes for Change media boo:

() Define new rectangle

Lowerleft [0.0000t

| [0.00005t |

Actions

Center page content ~ General Information
Change annctations’ print setting = Locking Irformation
Change art box =

Change binding - Select all

Change bleed box Resize media box

Change character spacing
Change color

Change comupt font widths
Change crop box

(Change dash pattem
Change default color spaces

Al Recent Favorites %
Change document encoding
= ‘ ﬂ ‘ ':;‘ ‘ Change document info
= - .‘ Change fill and/or stroke
Page Line Art Change fill type
« e E— ‘oo | [Change flatness
L A | fomwe
Calor Image Add/Remove s |mag§ SOmpIEeR
Change layering
-] 1 i Change line cap
_TI 2 3 = Change line join
Prepress  Position//Size Operator  |Change line weight
P
© L ] _a @ Change miter limit v
Metadata Doc General
Fitter [ Ak J
| | [ Addto Favorites

Click ‘Define new rectangle” and
enter Opt/Opt for Lower left and

595pt/792pt for

Select ‘Log as critical failure” and ‘'OK’

Then add “Remove

Enfocus Action List Editor: Untitled

General Information
Locking Information

Select all
Resize media box

Log

Upper right

CropBox”

Mtributes for Remove crop box:

No attributes available

Log

Log if change fails | Log as non-critical failure |«

Upperright | 595.0000pt

| |792.mmm |

) Resize

Delia'y: [B.00000

() Use box size

Position content

Move page content to

Log Log

Log if change fails | Log as critical failure 2

b

™

Hew Action Type for Action List: Untitled x|

Types

3
a3 als

&
Gredes

Selections Changes Informs
Categories
Recent Favortes
| -
=] ‘ T ‘ & ‘\‘
Page Text Line At
v S
) I .
Color Image Add/Remave
el I )
i a3 il
Prepress  Position/Size Operator
—
& =7 3
Metadata Doc General
Fitter

Actions

(Optimize document structure ~|
Overprint on all separations W
(Ovemde color management settings

Put selection in form

Release mask

Femap altemate color space to CMYK
Remap color

Femap spot color

Remove action dictionaries

Remove atemate images

Remove art box

Remaove black generation

Remove bleed box

Remaove Cerffied PDF wordlow infar...

rop box
Femove document structure compres...
Remove Empty Page
Remove file specification from streams |
Remove form fields -
Remove halftone

Remove halftone phase
Remove ICC tag
Remove invisible objects
Remove Javascript

=

Dlesemmisren s sl ol vrmidcarst

[ pa J

| [ Add to Favortes ]

Click OK



In earlier PitStop versions (before version 7) this script can be attached to a button, as shown
below.

P& Adobe Acrobat
Fle Edt Document Tools CertfledPDF PlugIns Wiew ‘indow Help

@R A|0 @ % & B > H]ofex - @O0 -
apOE|«#[E-F-2-B|0&- B804 A =] REE
Tl o A A AL B

=l&lx|

Bsuas T8

Click to select an Action List

From PitStop 7.0 this is no longer possible and it is necessary to have the Action List Control
Panel open all of the time

10



Setting up PDFMaker (WORD/EXCEL/PowerPoint)

It is safer to use the generic PostScript Printer to generate the PostScript file and then
use Distiller.

If it is necessary to use PDFMaker then do the following.

Enable the PDFMaker toolbar: View > Toolbars > PDFMaker 7.0 if the icon does not appear
in the application.

From the Acrobat menu on the tool bar > Change Conversion Setting

Set Conversion Settings to JACoW-08 (as for Distiller) and set up the Settings tab as seen
here then change the Office and Bookmarks Tabs as shown below (an older version but the
principle is still valid).

£ Acrobat PDFMaker x|

Settings |Security| Word I Bookmarks I

 POFMaker Settings
Conversion Settings: IJACDW-DE ﬂ

@ Setup For JACoW - paper size, embed all fonts, compression, Acrobat 5 compatibilicy.,

V¥ wiew Adobe POF result
[ Prompt For Adobe POF file name:
[ Corwvert Document Infarmation

Advanced Settings ...

- Application Settings
[~ attach source file to Adobe POF

™ add bookmarks to Adobe PDF
[ add links to Adobe PDF
[ Enable accessibility and reflow with Tagged PDFE

® Copyright @ 1987-2005 Adobe Systems Incorparated and its licensars., All rights
"‘ reserved, Adobe, the Adobe logo, Acrobat, the Acrobat logo, PostScripk, and
the PostScript logo are either registered trademarks ar trademarks of Adobe
Adobe Systems Incorporated in the United States andfor okher countries.

Restare Defaults | QK I Cancel Help

11



&2 Acrobat PDFMaker

Settings I Security  Word |Bl:n:|kmarks I

Ward Features

[~ Lonvert displayed comments to notes in the PDF:

[ Convert footnote and endnote links

[ Convert cross-references and table of contents to links

Comments

Rerigmer

| Include | Mokes open |COIor| # of camments |

Mo camments

Restare Defaults | QK I Cancel | Help |
£2 Acrobat PDFMaker x|
Settings I Security I Word  Bookmarks |
r Bookmark Options
[ Corvert ‘Word Headings o Bookmarks
[ Corwvert Word Styles to Bookmarks
Element | Tvpe | EBookmark | Level | =
“=Heading 1 Heading ] 1
“=Heading 2 Heading | 2 | |
“=Heading 3 Heading [ 3
“=Heading 4 Heading ] 4
“=Heading 5 Heading | 5
“=Heading & Heading [ A
“=Heading 7 Heading | 7
Heading [ &
“=Heading 2 Heading | 9
9] Balloan Text Skyle [ 1
9] Block Text Skyvle | 1
9] Body Text Skyle [ 1
1| Body Text 2 Skyle ] 1
¥ Body Text 3 Skyvle | 1 ;I
Restore Defaults | oK I Cancel Help

12




Using Acrobat 7 PDF Optimizer
For Expert Usage Only

Set up as follows:

Change compeatibility level to Acrobat 7.0 and later

PDF Optimizer
Prezet; |JAC0W—09 vl Delete ;EL, 53 Audit space usage...

Preset Setiings

Current PDF Version: 1.6 (Acrobat 7.x) Make compatble with: | Acrobat 7.0 and later v |

Image Settings
| Scanned Pages

Fonts

Transparency

Discard Objects Compression: | JPEG v | Quality: | Maximum
Clean Up

Color Images :

Downsample: | Bicubic Downsampling to | % | JSDD pixelsfinch. For images sbove |450 pixelsfinch

Grayscale Images :

Downsample: I Bicubic Downsampling to | % | 1300 pixelsfinch. For images above I45[J pixelsfinch

Compression: | JPEG % | Quality: | Maximum %

Menochrome Images :

Downsample: |.¢werage Downsampling to V| 11200 pixelsfinch, For images above  |1800  pixels/inch

Compression: | CCITT Group 4 %

[ OK ] [ Cancel

13



Font manipulation is dangerous — be sure not to un-embed any if you have to use the
optimiser.

PDF Optimizer
Preset: | Custom il | i t Audit space usage. ..

Preset Setlings
Current PDF Version: 1.6 (Acobat 7.x) Make compatible with: i Acrobat 7.0 and later b |
S Font Settings
Images
Scanned Pages The following fonts can be unembedded by the PDF Optimizer:
Fonts
Transparency Embedded fonts: Fonts to unembed:
Discard Objects [ Times TimesNewRomanP5-BoldMT (Subset)
Clean Up Times-Bold (Subset) TimesNewRomanPSMT (Subset)

Times-BoldItalic (Subset)
Times-Italic (Subset)
Times-Roman (Subset)

<< Retain

The fonts listed above are currently embedded in the PDF, To unembed a font, move it to the right
pane, Fontz listed in the left pane will remain embedded.

[ OK. ] [ Cancel ]

The list of fonts is made automatically and is specific to each file — don’t un-embed any

fonts — move them to the other side by selecting and clicking Retain.

This step has to be executed each time you use optimizer.
The Preset will change (when selecting the fonts) from JACoW-09 to Custom.

PDF Optimizer
Preszet: | Custom b | [ De Audit space usage. ..

Preset Settings
Current PDF Version: 1.6 (Acrobat 7.x) Make compatible with: | Acrobat 7.0 and later A |
Font Settings
Images
Scanned Pages The following fonts can be unembedded by the PDF Optimizer:
Fonts
Transparency Embedded fonts: Fonts to unembed:
Discard Objects [Times
Clean Up Times-Bold {Subset)

Times-BoldItalic (Subset)
Times-Italic (Subset)
TimesMewRomanPs -BoldMT (Subset)

TimeshewRomanPSMT (Subset)
Times-Roman (Subset)

| <<Retain

The fonts listed above are currently embedded in the PDF. To unembed a font, move it to the right
pane, Fonts isted in the left pane will remain embedded.

CK ] [ Cancel

14



Preset: | JACoW-09

Preset Setlings

Images
Scanned Pages
Fonits
Transparency

| Clean Up

Current PDF Version: 1.6 (Acobat 7.x)

Make compatible with:

Discard Objects Settings
[#]Discard all comments and form widgets
Discard all form submission, import and reset actions
Discard all JavaScript actions
[#]Discard all external cross references
[#|Discard all alternate images
[piscard embedded thumbnails
[¥|Discard private data of other applications
Discard document structure
[¥] Discard hidden layer content and flatten visible layers
Convert smooth lines to curves
Detect and merge image fragmenis

Audit space usage...

Acrobat 7.0 and later ~ |

OK ] [ Cancel

PDF Optimizer

Preset Settings

Images
Scanned Pages
Fonts
Transparency
Discard Objects

Preset: | JACoW-09 N

Current PDF Version: 1.6 (Acrobat 7.x)

Clean Up Settings

|
Object compression options: | Compress document structure | % |

Use Flate to encode streams that are not encoded
In streams that use LZW encoding, use Flate instead
Remove invalid bookmarks

Remove invalid links

Remove unreferenced named destinations

Optimize the PDF for fast web view

Make compatible with: | Acrobat 7.0 and later bl |

Audit space usage...

OK ] [ Cancel
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